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Chapter 1 Installation & Setup

1.1 wePrint Design Studio Files
The zip directory contains all the files that you need to install and setup the wePrint Design 

Studio. 

The db_extras folder contains the SQL files for configuring the database. The definitions_locale  
folder contains the definitions files for other languages besides English. The UPLOAD contains all the 
files that need to be uploaded to your server. Some of these files will need to be edited before 
uploading.

1.2 Pre-Installation Setup

1.2.1 Database Setup
You will need to create a database table for the wePrint Design Studio. If you are installing Zen 

Cart for the first time you will need this database for your Zen Cart data. At this point you will not load 
any data into the database. You just need to create a database, create a user, create a password. You will 
need this information for the installation of both Zen Cart and the design studio. You will also need to 
know the database server. Most hosting companies will have your database server set to localhost. 
Refer to your host for this information.

1.3 Pre-Installation Configuration Files
There are a few settings that need to be manually edited. You will need to edit these files 

1 and 2 before uploading, otherwise the design studio will not work. Files 3 and 4 can be edited at a 
later date since they only contain GUI text.

NOTE: Do not use a word processor, such as Microsoft Word, to edit any files. Word processors 
usually add extra hidden characters to the files that can create problems. We recommend a simple editor 
such as Notepad. There are more powerful editors out there that are available free of charge:

• Notepad++

• Bluefish HTML editor
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1.3.1 File 1: designstudio/connect_sql.php
This file is used to connect to your MySQL database, in order to save some the design 

information. You only need to change the text within the quotes of the DEFINE statements as shown in 
green-bold text.

DEFINE('DB_USER','USERNAME'); Change the USERNAME to the one that is used 
by your database.

DEFINE('DB_PASSWORD','PASSWORD'); Change the DB_PASSWORD to the one that is 
used by your database.

DEFINE('DB_HOST','localhost'); Change the DB_HOST to the one that is used by 
your database. The host is many times set to 
localhost. Check with you hosting company.

DEFINE('DB_NAME', 'DB_NAME'); Change the DB_NAME to the one that is used by 
your database.

1.3.2 File 2: designstudio/convert-location.php
This file contains the location of the ImageMagick program. This is specific to your hosting 

company server. The majority of the installs will have the Imagemagick residing at 'usr/bin/' or at 
'/usr/local/bin'. You can determine this by asking your hosting company. Or use the weprint-test.php 
utility. The utility will tell you if the Imagemagick is installed at either of the two popular locations.

Once you have determined the location, change the file as necessary. Change only the text 
highlighted below:

$CONVERT = "/usr/bin/convert";

$IDENTIFY = "/usr/bin/identify";

$MONTAGE = "/usr/bin/montage";
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1.3.3 File 3: designstudio/definitions.php
This file contains much of the text that is displayed within the design studio. The text is broken 

into variables. There are many chunks of text so you will need to browse through the file to find the 
text that you want to change. You can only change the text within the quotes. Do Not change the 
variable name.

example: $WEP_loading_text = 'Design Tool Loading. Please Wait.....';  You can only change the 
highlighted text. Do not change any other code. If you are going to use special characters such as '&' 
you will need to use the html encoding (&amp; = &).

1.3.4 File 4: designstudio/includes/jscript_DT1.js
This file also contains some of the text that is seen within the design studio.

IMPORTANT: You can break the design studio if you edit any code other than the text at the top of the 
file. The editable code is:

//BEGIN USER EDIT TEXT////////////////////////////////////////////////////////

Only edit the code within this block.

//END USER EDIT TEXT/////////////////////////////////////////////////////////

Replace only the text within the quotes.

example: var alert_delete1 = "Do you want to Delete the selected item?"; You can only change the 
highlighted text.

Chapter 2 Uploading the Files

2.1 Introduction
After you have edited and saved your configuration files, you will need to upload the files to 

your server. There are two types of installations:

1. New Zen Cart Store - Upload the contents of the Full-Zen-Cart directory and the contents of the 
wePrint directory.

2. Existing Zen Cart Store – Upload only the contents of the wePrint directory.
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WARNING: wePrint Design Studio ships with a complete set of Zen Cart files. If you 
have an existing Zen Cart store, you MUST only upload the files specified below. The 
differences are outlined below.

WARNING: Always backup your site files before uploading and installing.

WARNING: If you have an existing database, be sure to backup this database before 
running the installation.

2.2 New Zen Cart
This section describes the installation of the combined wePrint Design Studio & Zen Cart. You 

should only follow these instructions if you are going to install the wePrint Design Studio with a new 
Zen Cart install.

WARNING: If you have an existing Zen Cart store on your site, you can not perform a new install of 
Zen Cart. Doing so can potentially destroy your existing Zen Cart database.

If you have an existing Zen Cart store and want to add the wePrint Design Studio, you should 
skip this section. The figure below shows all the files and directories within the UPLOAD/Full-Zen-
Cart folder. All upload the contents of the entire UPLOAD/Full-Zen-Cart directory to your top-level 
directory of your store. The can be the top-level of your domain (i.e. mydomain.com/). Or within a sub-
directory such as store (mydomain.com/store). 
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2.3 Uploading the wePrint Files
Once you have uploaded the Zen Cart files (or if you have an existing Zen Cart store) you will 

upload the contents of the UPLOAD/wePrint directory.

NOTE: Unless you have a previous design studio installation on your site, these files will not 
overwrite any existing files, with one exception. The following file will overwrite the existing file. You 
should rename the existing files on your server, in case you need to revert to the older files (i.e. 
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filename-old.php).

/includes/modules/pages/product_info/header_php.php
/includes/modules/pages/product_info/main_template_vars.php
includes/templates/weprint1/common/html_header.php
/includes/modules/pages/shopping_cart/header_php.php This file is modified so that the 

default cart image for a product 
that is customized with the design 
studio will be replaced with the 
thumbnail image for the design.

The design studio ships with a template, weprint1. This is very similar to the default Zen Cart 
template, with a wider page, to accommodate the design studio. If you are going to use this template 
you can simply upload the includes directory to your server. However, if you are going to be using you 
own template, you will want to copy any of the files that are in the weprint1 directory to the appropriate 
template directory on your server. The table below shows which files are template specific.

includes/languages/weprint1/english.php
includes/languages/english/html_includes/weprint1
includes/languages/english/weprint1
includes/templates/weprint1

These files will overwrite the files in your template, so be sure to rename the existing files, in 
case you need to go back.

2.4 Encrypted Files
There are some files that are encrypted and not included in the standard design studio zip folder. 

There is a separate encrypted folder that needs to be downloaded. You should have received 
instructions for downloading these files, if you requested a demo. The following files need to be 
uploaded to your site:

designstudio/encrypted  (uploaded this entire directory)

includes/templates/weprint1/templates/tpl_product_info_display_wep.php
Without these files you will not see the designstudio loaded into the product page. Also the 

encrypted directory is needed for the design studio to function properly.
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For the demo version, these files are set to expire in 30 days. If you purchased the design studio, 
you will receive permanent files to replace the temporary files. The permanent files will be encrypted 
so that they will only function on the website that you specify during the purchasing process.

2.5 Post Upload File Permissions
For a new Zen Cart install you will need to change the permissions of some of the files specific 

to the Zen Cart operation. A list of file permissions, along with a quick installation guide can be found 
here: 

• Zen Cart Install Guide  

To summarize the necessary steps to prepare for an installation:

1) Two files need to be created on the server. These are the configure.php files that identify the 
settings of your particular server and the location of the files that you just loaded. After they 
have been created, you will then need to change the permissions on these files. 
 On the server locate the file: includes/dist-configure.php 
Rename this file to configure.php and change the permissions to 777 (read-write-execute for all)

Next, on the server locate the file: admin/includes/dist-configure.php 
Rename this file to configure.php and change the permissions to 777 (read-write-execute for all)

2) Change the file permissions of the following files/directories: 

• cache
• images 
• includes/languages/english/html_includes 
• media 
• pub 
• admin/backups 
• admin/images/graphs 

• images/attributes 
• images/banners 
• images/categories 
• images/large 
• images/manufacturers 
• /images/medium 
• images/upload 

For the design studio, you will need to change the permissions on the files shown in the table 
below. Some of the files must have write-access or the design studio will not be able to create text 
and/or save designs. 
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Directory File Permissions
designstudio wep-zen-config1.xml 0x777
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Directory File Permissions

designstudio/includes
shop-defaults.xml 0x777
wep-tool-config.xml 0x777

designstudio/configs/screenprint/includes
wep-tool-config.xml 0x777

designstudio/images Directory 0x777

designstudio/fonts Directory 0x777
fonts.xml 0x777
fonts.png 0x777

designstudio/printadmin/saveddesigns Directory 0x777

designstudio/products Directory 0x777
Adult-Short-Sleeve.xml 0x777
Ladies-Short-Sleeve .xml 0x777
Youth-Short-Sleeve .xml 0x777
Screen-Printed-Tee .xml 0x777

designstudio/saveddesigns Directory 0x777

2.6 Zen Cart Installation
If you have an existing Zen Cart store you can skip this section. Once you have changed the 

permissions on the files according to the previous section, you can install Zen Cart. To begin the 
installation, simply navigate to your store location (mydomain.com/zc_install/index.php).

Do not activate the “Store Demo” button during the Zen Cart installation. This is intended to 
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install the plethora of products that are included with the Zen Cart installation package. The product 
files have been removed from the wePrint/ZenCart install package so you won't be able to install them. 
Also, in a later step you will add some of the wePrint products to the store via the database.

2.7 Zen Cart Store Setup
At the completion of the Zen Cart install, you should open two tabs in your browser. In 

one tab, navigate to the store home page. In the other tab, navigate to your store admin page. With the 
two tabs open you will be able to see the changes made in your admin section.

2.7.1 Import Database Information
At this point you will need to load your database with the wePrint demo products and also 

create the tables for saving the designs. 
1) Go to your database admin page.
2) Import the wep_demo_products.sql file (in the db_extras folder of wePrint package)
3) Import the Designs_Main.sql file (in the db_extras folder of wePrint package)
4) Verify that there are no errors during the import. 

2.7.2 Zen Cart Security 
If you navigate to your store page, you will see some red warnings at the top. This warning is 

reminding you to do the following:
1) Change the includes/configure.php files back to 644 permissions.
2) Remove the zc-install directory or rename it.

As another precaution it is recommended that you change the name of your admin page to 
something less obvious. To do this simply change the name of the admin directory. In this case, you 
would navigate to the new named directory to get to your admin page (so mydomain.com/new_admin 
instead of mydomain/admin). 

2.7.3 Change Template
The wePrint Design Studio ships with a template, weprint1. This template is very similar to the 

standard Zen Cart template, but is wider for the design studio. The template also changes the “more 
information” side box, so that it contains the links to you design studio page(s).

In order to use the template, you need to change the template selection in you admin page:
1) Within your admin page go to Tools=>Template Selection.
2) Click the Edit button in the right sidebox.
3) Select the weprint1 as your template from the drop-down menu.
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2.7.4 Change Sidebox Display
When you change to this new template, many of the sidebox settings change, so that most side 

boxes are hidden. You can go to Tools=>Layout Boxes Controller and you will see  a list of all the 
sideboxes. For the demo site, we have turned-on:

1) Categories – Set to the Left with an order of 0.
2) Shopping Cart – Set to the Right with an order of 0 so it is at the top.
3) Search – Set to the Right with an order of 1.

2.7.5 Shopping Cart Thumbnail Size
The cart thumbnail size is 50px by 40px. This size is too small to truly see the design on the 

shirt. We suggest changing this to 150px by 150px. Go to Configuration=>Images. Change the
 Image - Shopping Cart Width and the Image - Shopping Cart Height values to 150 each.

2.7.6 Your New Store
Go to your store and refresh the page if necessary. You should now see the products listed. you 

should see the the sidebox with design studio links. Click on one of the links. You should get a fully 
functional design studio. You should be able to create designs, save designs, and and a design to the 
cart. If you have any problems, please review the Post-Install Troubleshooting Guide.
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List of Quick Changes:

TBD
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Chapter 3 wePrint Admin
All of the files that control the products within the design studio, can be edited manually. You 

may also use the admin page to configure products and also perform a few other design studio 
customization.

The wePrint admin is found within the Zen Cart admin portion of your site. There is no direct 
link to the wePrint admin page within the store admin section. However, you will need to log into your 
store admin section before you can reach the wePrint admin page.

Once you have logged into your store admin section, type the following address into your 
browser: yourStoreDomain/admin/weprint_admin.php

You will be re-directed to a page as shown:
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From this page you can:

1) Edit the design studio configuration.

2) Open and edit the fonts gallery file.

3) Define the products that use the Design Studio.

4) Correlate Zen Cart options to design studio options.

5) Define RGB color values for thumbnail images.

6) Edit a particular product configuration.

3.1 Correlating Zen Cart  Options
Within your Zen Cart store you have created the options for you products (i.e. color, size, design 

ID, etc). The design studio does not necessary know what your options are. For example, you may have 
called your 'color' option as 'colour'. If you click on the “Open Options Selector”, you will be presented 
with a dialog box:

The design studio uses the 6 option names on the left: 1) Sizes, 2) Colors, 3) Print Locations, 4) Design 
ID, 6) Styles, 7) Number of colors. Next to each option name, is a drop down menu that lists all the 
options in your Zen Cart store. To the right is the “Current Setting” and the “Synch” button. To change 
an option name, just select the option name from the dropdown menu and then select the synch button. 

3.2 Tool Configuration
If you click on the “Edit Tool Configuration” button, you will be presented with a dialog box 

that allows you to enable, disable, and set certain properties.
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Name Purpose
Show Add to Cart Do you want the “Add To Cart” button to show on the post-save dialog 

window. 
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Show Quote Submission Do you want the customer to have the option to submit a request for a 
quote for a saved design.
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Show Price Sheet This will show a button that allows the customer to display a dialog box 
which will list the product pricing. May be useful to display pricing based 
on color and size.

See the section on configuring the price sheet, for details on creating and 
styling the pricing table.
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Show Our Designs Do you want the button and dialog box that displays a list of pre-
configured designs that the customer can open, edit and save-as. yes or no

revision: November 09 2010 Page 20 of 44



wePrint Design Studio Users Guide

Instant Quote This will enable the dynamic pricing window for designs that are based on 
the number of colors. See the pricesheet.xml file description for details on 
the pricing information that can be displayed. yes or no

Show Zen Side Cart By default this is set to no. So the side cart box will not be shown on the 
pages that have the design studio loaded. The reason is due to the fact that 
the Zen side cart box view will not update if you add a product to your cart 
from the design studio. You will receive an alert that the product was 
added. If you navigate to a different page or refresh this page, the cart will 
show any newly added products. This lack of a cart update may confuse 
customers, so we recommend hiding the quick cart on the design studio 
page(s).

Currency Symbol This is the currency symbol that is used in the instant quote dialog box.
Shop Code This is the three digit code that is used for the naming of the saved 

designs. A saved design is name as follows: ABCxxxxxxxxxxxx.
Where “ABC” is the shop code and the rest is a unique random number 
assigned when the design is saved by the customer.

Email This is the email address that will be shown as the reply-to email address 
for saved designs and for the “Quote Submission” form.

Thumbnail Width This is the size of the thumbnail of a saved design, which appears after the 
design is saved. This is not the same thumbnail size as the shopping cart 
image which is set from your Zen admin page.
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Once you have set the parameters use the “Update....” button to save the settings. The drop-
down menu is used to select the configuration. If you have more configurations than the default 
configuration, simply select the configuration you want saved. For more information on using mutliple 
tool configurations see the chapter title “Running Different Design Studio Configurations”.

3.3 Fonts Gallery File
Before editing the fonts gallery file, be sure that you have loaded the font file to the 

designstudio/fonts directory. The font file must be a ttf font and have an extension of “.ttf”. Also, the 
name of the ttf file will need to match the name that you have in the fonts list. You can not have a font 
file name that has spaces. If the name has any spaces in it, replace the spaces with a dash, “-”. 

example: you have a font called My Font. You will need a file My-Font.ttf. 

The case is critical and the font name must match exactly the font file name.

To edit the fonts file you can click on the “Open Existing Fonts File” button.

The fonts will be displayed within your gallery in the order as seen in this dialog box. Within this 
dialog box you can:

1) Remove a font

1. Delete the name from the list

2. Be sure to remove any blank lines.

2) Add a font:
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1. Simply add the name between any two fonts.

2. IMPORTANT: If you add a font to the bottom of the list, you will need to add a carriage 
return after this font. Sometimes, the gallery will not see the last font if there is no 
carriage return after the last font name.

Once you have made changes, click on the “Update Fonts File” button. The fonts gallery file will be 
updated along with the fonts gallery image. If a font file is missing you will receive an error message. 

3.4 Including Products in the Design Studio
The Zen Cart store admin section does not include a direct method for selecting a product as a 

product that will use the wePrint Design Studio. By clicking on the “Open Existing Products File” 
button you will be presented with a dialog box. This dialog box displays a list of the products that are 
currently included. The drop-down menu lists all the products in your Zen Cart store.

Add a Product
To add a product select the product from the drop-down menu and click on the “Add Product...” button. 
A confirmation notice will inform you that the product has been added. The list on the top will be 
updated to reflect the new product. 

Remove a Product
Removing a product from the design studio, will not remove it from the Zen Cart store. Select 

the product from the drop-down menu and click on the “Remove Product...” button. You will receive a 
confirmation notice and the list will be updated.
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3.5 Configuring a Product
Each product needs to have the product images located in the 

designstudio/toolimages/blanks/PRODUCT-NAME directory. Where PRODUCT-NAME is the name of 
the product as it appears in the Zen store. Any spaces MUST be replaced with dashes, “-”.
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Example:
We have a product:  Adult Short Sleeve Tee.

We need to create a directory -  designstudio/toolimages/blanks/Adult-Short-Sleeve-Tee. Within the 
designstudio/toolimages/blanks/Adult-Short-Sleeve-Tee directory we will have the front and back image 
for each color. The file name format is:

Color-location.png  Where Color is the color name and Location is either “front” or “back”. This file 
name is case-sensitive. If we have two colors, White and Black, then we would have the following 
images in the directory:

White-front.png
White-back.png
Black-front.png
Black-back.png

The image must be a png image. No other image format is supported at this time.

Once you have the product directory ready and the images in the directory, you can configure 
the product with configuration  information. From the admin page there are a few things you can do to 
configure a product:

1. Update an existing product.

2. Create a product configuration from scratch.

3. Copy an existing product configuration to another product.

In order to do one of the above options you need to click on the “List Products” button. This 
will load the drop-down menu with you products. This menu is created from your products-list gallery 
file. To edit an existing product, click on the product name. You will be presented with a dialog box. 
This box will show you the only option for this product - “Edit Existing Configuration”.
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Click on the button to continue. You will be presented with the product configuration dialog 
window. The Illustration below shows the various inputs. Each input is labeled with a red letter. The 
description of each input is described in below.

If there is no existing product, than you are presented with the option to create a new product 
configuration from scratch or to copy an existing product.

If you select to create a new configuration file from scratch, you will be presented with a blank 
product configuration dialog box.

If you select to copy from another product, the dialog box will close and you can select the 
product again from the drop-down menu. Now, selecting from this drop-down menu you will be 
directed to the newly created product configuration dialog box (as copied from the other product).

Once you have selected which route to take for this product, you will be presented with the 
product configuration dialog box:
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Dialog Box Inputs:
A) Front Printing – Is the front of the product printable? Yes or No.

B) Back Printing – Is the back of the product printable? Yes or No.

C) Default Print Location:

1. Location - “F” for front or “B” for back.

D) Front Printable Area – See the illustration below for a description of this parameters. Depending 
on your product you will need to adjust the placement and size of the printable area. If there is 
no front area, this input can be left blank.

E) Back Printable Area – Same as front printable area.

F) Update Product Configuration button – Once you have made changes, use this button to update 
the configuration file.

G) New Product Configuration button – If this is a new product than use this button to create the 
product configuration file after you have made you edits.
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3.6 Configuring Product – Colors
You need to define the RGB value for each color that you have. This RGB value is used to 

create the thumbnail of the saved design. Click on “Open Color RGB Selector” button and you will be 
presented with a dialog box that you will use to correlate each color name to an RGB value.

The dialog box will list all the colors that are in the Zen store. For each color, place the RGB 
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value in the corresponding box. Be sure to include the '#' symbol. Once you have entered the 
information, click on the “Update Colors” button.

Chapter 4 Configuring wePrint for Screen Printing
If you are a screen-printer you most likely will want to enable the Instant Quote feature. This 

feature will give the customer pricing based on the number of colors in the design. You can define:

1) The price per color.

2) The quantity price breaks.

3) The price of the product based on color.

4) The maximum number of colors per design.

Currently, the pricing tool will not except uploaded images from the customer. Once a customer 
uploads an image, they will receive a message stating that the instant pricing will be disabled since they 
have added an image.

First set the discounts prices in the Zen Cart admin page using the Product Price Manager.

Once you have the prices set in the Zen cart store you will need to manually edit one file for the 
design studio:
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Currently the pricing does not use the Setup Per Color parameter. So it should be left at zero. 
The price per item is as follows:
Price = (number of colors on Front) X pricePerColor + (numbercolors on back) X pricePerColor + blankPrice + 
breakPointPrice

Example: If the design is on a black shirt, has 3 colors on the front, no colors on the back then the 
pricing will be calculated as:
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Essentially, you have a base price for the color of product and a base price dependent on the 
quantity of product ordered. You then add to this the price per color. The price per color is calculated 
based on the colors on both sides of the product if the design has printing on both sides.

The price breaks need to match the discounts that are created within your Zen Cart store.

Chapter 5 Running Different Design Studio Configurations
There may be cases where your store has unique products that require different design studio 

settings. For example, you may have some products that are direct-to-garment printing and some that 
are screen printed. In this case, your could setup you main design studio page for direct-to-garment 
printing. On the other design studio page, you will enable the instant pricing so the designs can be 
priced per color.

5.1 Setting-up the Files and Directories
We will set up a screen printing product. Within the designstudio directory there is a directory 

named configs. This directory is used to override some of the default configuration files. On our local 
computer, we will do the following:
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1. Copy designstudio/includes/wep-tool-config.xml to designstudio/configs/screenprint/includes/.
2. Change the permissions on the new file to 777.

5.2 Creating the Product Files
Once you have uploaded the files and directories to your server, you can go to the wePrint 

admin page. From here you will select your configuration for the drop-down menu:

Now when you click on the “Open Existing Products File” button, the tool will look into the 
screenprint override directory. Since we don't have a configuration file there, it will tells us so. We will 
be presented with an empty input box for creating the products configuration file:
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 Copy the “Adult Printed Tee” line from the bottom box and place it into the top. Add a carriage 
return and select the “Update..” button. A configuration file will be created in the screenprint override 
directory along with the products gallery image. Keep in mind, you will still need to upload the product 
background images to the designstudio/toolimages/blanks/PRODUCT-NAME/ directory. In this case 
the directory will be Adult-Printed-Tee.

At this point, if you navigate to index.php?main_page=page_2 you will see the design studio 
load with the proper products gallery and with the instant quote pricing turned-on. To configure your 
store so that page_2 will show-up in the links with your desired name, refer to the “Zen Cart 
Customization” section.

Chapter 6 More Customization

6.1 Adding/Removing Symbols
The main symbols configuration file is designstudio/symbols/symbols-list.xml. This file lists the 

categories that are to be shown in the gallery. Each category name has a corresponding 
categoryname.xml file. Any spaces within the category name should be replaced with a "-". So a 
category named "Clipart 1" has a corresponding file Clipart-1.xml. You can add or remove a symbol 
category simply be adding or removing the tag for that category.

Symbolname.xml
The category xml file contains a list of all the symbols in the category. Each symbol must have a 
corresponding png file with the same name. (spaces replaced by "-")

6.2 Modifying the Color Palette
There are two color palettes that can be modified to hold the colors that best suit your needs; 1) 

the text/symbol color palette and 2) the text outline color palette. There is one file that needs to be 
modified in order to edit these palettes. 

Open the includes/modules/pages/PAGE/jscript_colors.js file in your editor. Where PAGE is 
either Page_2 or Page_3.  At the top of the file you will find the following code: 

Text/Symbol color table within colors.js 

var textcolors = {
colorData: {
'#000000': 'black',
'#FFFFFF': 'white',
'#7E7E7E': 'gray',
'#D3D3D3': 'LightGray',
'#696969': 'DimGray',
'#FF0000': 'red',
..
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..

..
'#483DB3': 'DarkSlateBlue',
'#1E90FF': 'DodgerBlue',
'#ADD8E6': 'LightBlue',
'#B0C4DE': 'LightSteelBlue',
'#DDA0DD': 'plum'}
};

You can add or remove a color by simply editing the color hex code and the color name. Be sure 
to follow the correct punctuation, including single quotes around the hex code and the color name. The 
hex code is the more important piece of information since it is used to fill-in the text or symbol. The 
color name can be any alphanumeric name you want. 

The color table for the text outline appears at the bottom of the 
includes/modules/pages/PAGE/jscript_colors.js file. It can be modified in the same manner as the 
text/symbol color table.

6.3 Modifying the Stock Images Gallery
The wePrint Design Studio ships without any images in the stock image gallery. The directory 

that contains the configuration files and the image files is designstudio/stockimages. The stockimages 
directory will look like:

The imagegroups.xml file determines the groups listing in the gallery. Each image group has a 
groupname.xml file and a corresponding groupname directory. The groupname directory holds all the 
images for that particular group. Here is the view of the Animals directory:
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When the design tool loads it looks at the imagegroups.xml file and presents a list of the groups 
in the stock images gallery. You can edit the imagegroups.xml file in a text editor. To add a group to the 
files just add the group-name to the file between a set of <group> tags. 

<?xml version="1.0" encoding="iso-8859-1"?>
<groups>
<group>Flags</group>
<group>Animals</group>
<group>Sports</group>
</groups>

Note: The name of the group is case-sensitive and must match the groupname.xml filename and the 
groupname directory. For example, we have Animals in the imagegroups.xml file, we have an 
Animals.xml file that defines the images that are in the group, and we have an Animals directory that 
holds the images.

Note: Group names may have spaces. However, the corresponding group-name.xml file and the 
directory must have the spaces replaced with a dash "-". For example a group names Large Animals 
must have a Large-Animals.xml file and a Large-Animals directory. 

If you wish to keep the stock images gallery empty, the imagegroups.xml file needs to look like:

<?xml version="1.0" encoding="iso-8859-1"?>
<groups>
</groups>

Once you have added a group to the imagesgroup.xml file, you need to create the group-name.xml file. 
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The Animals.xml file looks like:

<?xml version="1.0" encoding="iso-8859-1"?>
<images>
<image>Anonymous_turtle.png</image>
<image>ArtFavor_Sheep_(Ewe)_2.png</image>
<image>Anonymous_emperor_penguin.png</image>
<image>zeimusu_Leaping_cat.png</image>
<image>Anonymous_the_elk.png</image>
<image>zeimusu_spotty_dog.png</image>
<image>ArtFavor_Cartoon_Sheep.png</image>
<image>zeimusu_nayrhcrel_Wood_Ibis_2.png</image>
<image>zeimusu_nayrhcrel_Wood_Ibis_1.png</image>
<image>ArtFavor_Sheep_(Ewe).png</image>
<image>zeimusu_Lion.png</image>
<image>Anonymous_Tiger.png</image>
<image>AlanO_Kittens_One_with_Blue_Ribbon.png</image>
<image>zeimusu_lion_face.png</image>
<image>zeimusu_Magpie_2.png</image>
<image>addon_the_crab.png</image>
<image>zeimusu_Magpie.png</image>
</images>

Copy and paste the Animals.xml code as a starting point for your file. Simply change the image-
name between each <image> tag. 

Note: The image file names must match exactly the file name in the group directory. File names can 
NOT have and spaces in them. Replace any spaces with a dash or underscore. Remember, file names 
are case-sensitive.

Any image file that is in the directory but not included in the groupname.xml file will not show-
up in the gallery. So, if you want to remove an image from the gallery. Remove the <image> tag in the 
xml file. Leave the actual image file in the directory, in case you decide to add it again later. 

6.4 Modifying the Our Designs Gallery
The Our Designs gallery can be turned-on or off from the wep-config-tool.xml file. This gallery 

allows you to categorize designs for your customers. You may have different generic designs for 
businesses, sports teams, charities or any other category. There is no known limit to the number of 
categories or designs per category. The gallery will include a scroll-bar if the number of designs 
exceeds the height of the dialog box. Once a customer selects a design, the design will open in the 
designer and they can edit the design and save it under their email address. The wePrint Design Studio 
ships without any designs in the Our Designs gallery. The directory that contains the configuration files 
and the design files is ourdesigns. Here is the listing of ourdesigns directory from a simple example. 
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The our-designs-categories.xml file determines the categories listing in the gallery. Each 
category has a categoryname.xml file. The directory for each design must be within the ourdesigns 
directory. Here is the sample our-designs-categories.xml: 

<?xml version="1.0" encoding="iso-8859-1"?>
<categories>
<category>Standard</category>
<category>Business</category>
<category>Sports</category>
</categories>

With this example there are three categories (Standard, Business, and Sports). As can be seen 
from this code, each category has a corresponding xml file. The category.xml will list the thumbnails 
for each design in that category. Here is the sample Standard.xml file: 

<?xml version="1.0" encoding="iso-8859-1"?>
<designs>
<designThumb>ABC125392769812751-thumbF.png</designThumb>
<designThumb>ABC125393427317784-thumbF.png</designThumb>
</designs>

Each thumbnail corresponds to a design that is in the design directory. The design can be any 
design that was saved using the design tool. Simply copy the entire design directory from the 
saveddesigns directory into the ourdesigns directory. 
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Chapter 7 Print Admin

7.1.1 Introduction
The wePrint Print Admin is found within the Zen Cart admin portion of your site. There is no 

direct link to the wePrint Print Admin page within the store admin section. However, you will need to 
log into your store admin section before you can reach the wePrint admin page. From this page you can 
create an enlarged image from a customer's design or create a java script file which can be loaded into 
Adobe Illustrator (requires AI CS3 or greater).

Once you have logged into your store admin section, type the following address into your 
browser: yourStoreDomain/admin/weprint_printadmin.php

The Adobe Illustrator plug-in creates a java script file from a saved design. This java script file 
can then be "loaded" into an AI document. When the script is run within an AI document, all the objects 
from the design will be placed into the document in their proper locations. The process of loading a 
script into an AI document will be described in section 3.

Before using the AI plug-in tool we suggest you set up a location on your local machine to save 
the download designs. By default, the AI tool expects that you have each saved design in a folder 
within: c:\weprint\saveddesigns\

You would then download the saved design folder to this directory. For example:
c:\ weprint\saveddesigns\ABCxxxxxxxxxx (where ABCxxxxxxxxxx is the saved design ID) 

7.1.2 AI Parameters
Scale Factor

The scale factor is used to scale the design objects from the size that is seen within the designer 
to the actual size of your printable canvas. For example, the standard Adult tee that ships with the 
wePrint tool, has a printable area (on screen) of 350px X 400px. This is 1/4th the actual size of the 
garment (1400px X 1600px). The Scale Factordefaults to 4. For your particular medium you may find 
that a different scale factor is better (for example 3.8). You could set the scale factor to 1 and then do all 
you scaling from within AI.

Text Conversion
By default any text object in a design will be converted to an outline. You can choose to "Keep 

Text" as formatted text.

IMPORTANT: For best alignment you should convert the text to outlines. If you leave the text as 
formatted text, AI will place a larger bounding box around the text object. Also, the anchor point may 
be slightly different for text using a script font. The difference in the bounding box can create miss-
alignments in the AI document when compared to the original design as seen in the wePrint tool. We 
suggest that you convert text to outlines, unless you need to edit the text once in AI. Also, sometimes 
arched text may be cut-off when placed into AI. In this case, you should keep the text as formatted text. 
Once in AI, select the text on the arched path and decrease the font slightly. 
If you add new fonts to the gallery you need to run an AI font utility - see 3.4 below.

Symbol Conversion
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By default any symbol that is placed in the design will be converted to an outline in AI. This is 
the simplest way to handle the symbols that are in the symbol gallery, since they are single color and it 
is straight forward conversion from a png to an vectorized outline.
However, if you add other symbols to the gallery that may not be straight-forward in the conversion, 
you can change this option to - "Keep Symbols as Raster Images". In this case, the symbols will be 
embedded into the AI document as a raster image. You can then manually convert them to vector 
outline as needed.

Symbol/Image Location
By default AI expects that any images that are in a design can be loaded from 

c:\weprint\savedesigns\ABCxxxxxxxxx\. If you are on a MAC, or do not have the directory as above, 
than you will need to change this parameter to - "Select from AI Interface". In this case, when you load 
the saved AI script into your AI document, you will be prompted to specify where the images are 
located for the design. 

Once you have the files created (image file and/or AI file), you can create a zip folder. This folder will 
include all the files required for the saved design. Click on the download link to download the file. 
Clicking the link should bring up a dialog box to save the zip folder to your machine. As suggested 
above, we suggest that you save the files to the c:\weprint\saveddesigns folder and then extract the files 
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into a folder specific to that design (i.e. ABC123xxxxxxxxxx).

7.1.3 Loading File into AI
With the zip folder downloaded to your local machine, unzip the folder. You will now have a 

folder named ABCxxxxxxxx, which is the design ID. This folder will contain any of the files created 
from the steps above. If there are any symbols or images in the design, copies of these images will be 
included in this file. The steps outlined above will create a java script file for the saved design. The file 
will be named - ABCxxxxxxxxxx-F.js. The "F" refers to a front design. A back design will have a "B" 
appended to the file name. If the design has a front and a back there will be a java script file for each 
location.

Start with Blank Document
Open a new document in AI. The artboard needs to be set to the dimensions based on the design 

medium. For example, the Adult tee artboard should be 1400px by 1600px. 

IMPORTANT: By default, AI places the origin at the lower left corner of the artboard. The wePrint 
Design Tool uses the top left corner as the origin. Therefore, you need to place the origin of the 
artboard at the top left corner.
It will obviously save time if you save your standard artboard sizes along with the correct origin for 
future use. 

 Load the Javascript
From the File Menu, choose Other Script. This will launch a dialog box in which you can use to 

locate the js file for your design. Once you locate the design, and Open it, the script will load the design 
onto the artboard. If there are images in the design and AI can not find the default image location, 
another dialog box will appear. Use this dialog box to find and select the saved design folder. AI will 
now be able to find and load any images into the document. 
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Issue with Curved Text in the Downward Direction
When the design includes text that is curved (arched) downward. There is an extra step that may 

need to be taken. Figure 4 shows a design with text curved downward. The design tool curves the text 
below the line. AI by default, places the text above the line, see Figure 5. If the text seems to look 
different due to the placement, you can change the path alignment by going to Type => Type on Path 
=> Type Options and changing the Align to Path option from Baseline to Ascender. This change will 
place the text below the curve. See Figure 6.
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AI Fonts Utility
The font names in the drop-down menu are not a one-to-one correlation with the internal name 

of the font. For example, Arial is internally known as ArialMT. There is an xml file within the 
printadmin directory, AIfonts-conversion.xml, that translates the font name used in the wePrint Design 
Studio with the internal name required by AI. If you add fonts to your gallery, you will need to add a 
new font item to this xml file. In order, to find-out the internal names of the fonts on your system, there 
is a java script file, AI-fonts.js, within the extras folder of the AI install folder. You can open this script 
file from within a blank AI document and AI will output into this document the names of all the fonts in 
your system. You then need to add the font-name/AI-font-name pair to the xml file.
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